TS T P JUr. NP LR PR

PhotoStudio 2o ]
hagter H- Reference Fon

User Manual

PaletteS AND Tools

Windows® 3.X, Windows 95% and Windows NT®




Copyright 1994-1996, by ArcSoft, Inc. and Ricoh Company Lid, All rights reserved,

This manual and the sofrware described witchin are subject to a Sofrware License
Agreement. The software may only be copied in accordance with the license 2nd can
only be used on a single computer at any point in time unless a multi-user license has
been purchased. Copying of the manual is expressly forbidden withour the prior written
permission of ArcSoft, Inc. and Ricoh Company, Lid..

PhotoStudio is a repistered trademark of ArcSoft, Inc.

The Ricoh PhotoSrudio is a licensed sofcware licensed from ArcSeft by Ricoh for bundling
with Ricoh digital cameras.

PageMaker is a registered trademark of Aldus Corporation.

Photoshop is a trademark of Adobe System Corporation.

Microsoft Word and Windows are registered trademarks of Microsoft Corporarion.

Ricoh is a registered trademark of Ricoh Company Lid..

Other brand and product names are trademarks or registered trademarks of their
respective holders.

Credits For This Manual
Writing - David Chang and Kyle Coachman
Book design and layour - Li Yu

For software technica] support and product information, please contact:

Ricoh Corporation

475 Lillard Drive

Sparks, NV 89434 :
Tel 702.352.1600
Fax 800.544.8246

Interner: www.ricohcpg.com

Ricoh PhetoStudio for ‘Windows




Chapter 4
Reference For Palettes And Tools

By using the commands in the View menu, you can have three floating palettes - the Tools
Palette, the Color Palette, and the Brush Pelette - simultaneously displayed on the screen.

The Color Palette contains a varicty of predefined colors for quick color sclecting. The Brush
Palerte is used to define the size, shape, and drawing speed of the editing tools. The Tools

Palette contains twenty-four tools and two color swatches for image editing.

This chapter describes the three floating palettes and the tools in che Tools Palerze.
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The Color Palette

Color Palette

The Color Paletre shows a good sample of the colors you can choose for the active color in
Ricoh PhotoStudio. To call it up, choose the Show Color Palette command from the View

menu.

As you move the mouse over the palette, the mouse pointer changes to the Eyedropper Tool’s
pointer, and the status bar will display the RGB (or HSV) color values of the color that's
under the pointer. When you find a color you like, simply click on it to make it the active
color.

Of course, the palette’s colors change depending on the type of image you are working on. If
it is a 24-bit RGB True Color image, the palette will show a sampling of the millions of
colors you can use. If it is 8-bit Grayscale, it will show all 256 gray levels; if it is 16- or 256-
Color Indexed, it will show ail colors in the image’s color lookup rable; and if it is 1-bit

Black-and-White, the palette will display both black and white.

You can move the palette by clicking on its blue tde bar and dragging. To pur the palette
away, cither double-click on its title bar or chaose Hide Color Paletre from the View menu.
If the palette is displayed when you quit Ricoh PhotoStudio, it will reappear when you start
the program again.
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ﬂ Reference For Palettes And Tools

The Brush Palette

The Brush Palette gives you control over the shape of the brush thar is used by many of
Ricoh PhotoStudio’s major painting and retouching tools. To activate it, choose the Show
Brush Palette command from the View menu.

The Size setting changes the brush size, which is measured in pixels. The Speed serting alters
the rate at which the tools add their effects when you are moving the mouse. For example, at
higher Speed settings, the Paintbrush Tool will draw a solid line when the mouse is dragged
quickly. At lower settings, the rate will be slower and you will be able to create gaps in the
line by dragging quickly.

You can type in a value for Size and Speed, or use the up and down arrows. The top six
buttons allow you to pick various brush shapes that have variable sizes. The large butron at
the bottom is the user editable brush. If you double dlick on this button, the User Defined
Brush dialog box will appear to let you edit your own brush shape.

The User-Defined Brush dialeg box shows you a grid which corresponds to the shape of the
brush you are defining. Black squares on the grid are active, and will affect the image when
the brush is used. White squares are nor active. Click on a square to change its status; press
and drag in the grid ro change many squarcs.

You can change the size of your brush by changing the grid size. The largest size is 32 pixels
by 32 pixels. { Although the size of the grid in the dialog box does nor acrually change, the
density of the square changes. Since each square is equivalent to a pixel, more square means
that the brush will affect a larger area.)

You can also save brush shapes and load them back later when you wanr to use them. Brush
shapes are saved with a “.bsh” filename extension.

Ricoh PhotoStudio remembers the brush shape and size sertings when you quit and restores
them, or when you run the program again.

You can move the paletre by clicking on its blue title bar and dragging. To put the palette
away, cither double-click on its title bar or choose Hide Brush Palette from the View menu.
If the palette is displayed when you quit Ricoh PhoteStudio, it will reappear when you start
the program again.
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The Tools Palette and Tools

The Tools Palette contains tools for selecting, viewing, drawing, painting, retouching, and
editing images. It also contains controls for choosing the active and alternative colors.

When you move the mouse over its icon in the Tools Palette, a brief description of the rool
will appear in the main window’s status line. To sclect a tool, click on its icon.

Maost raols are affecred by the serring on the Brush Palerte and the color in the active color
swatch when you are painting ot editing an image. Some teols also have specific options
associared with them. To access rool options, doublc-click on the icon of a tool.

In the rest part of this chaprer, we will describe zll tools in the order from the top to the
botrom of the Tools Palerte.

Rectangle Select Tool

This tool allows you to select recrangular portions of your image. To use it, simply press and
drag in the image window. As long as you hold the mouse button down, you can change the
size of the selection you are making. Release the mouse burton when you have selected the
portion you want. The peinter position and the size of the selected rectangle are displayed in
the starus line (located at bottom of the Ricoh PhotoStudio window) during the selecting
operation.

If you decide you want to remove the mask you have created, click (but do not drag)
anywhere in the image, or choose None from the Mask menu.

You can also combine the existing mask with your new selection by holding down the Shift
key and dragging.
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Tip: To make accurate selections, make sure the mouse pointer is at one corner of the rectangular
area you want to select before you start to click and drag. If the options are set to Draw From

Center, you will want to make sure the pointer is at the center of the area you want to select. (See

“Oprions” below.)

When you double-click on the Rectangle Sefect Tool buron, a dialog hox will appear for
more options. Click OK to activate your setting.

Rectangle Select Option

Options in the Rectangle Select Tool dialog box:

Square

Draw From Center

Size Fixed

When this box is checked, the tool will always select perfectly
square areas of your image. If you try to select a rectangular area,
the tool will limit the size of the selecrion to the largest possible
square within that rectangular area,

Allows you to draw rectangular selections our from the center of
the area you want to select. When this option is on, simply click
ar the cenrer of the area you want to select and then drag the
mouse out toward any corner of the area.

When this option is turned on, the tocl will only select areas of
the fixed size you specify in the width and height fields. If you
turn the Square option on as well, Ricoh PhotoStudio will
require the width and height fields to be equal. Simply click on

the location on the image, 2 desired selection will appear.
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Ellipse Select Tool

This tool allows you to select elliprical or oval-shaped portions of your image. To use it,
simply press and drag in the image window. As long as you hold the mouse bucron down,
you can change the size and shape of the selection you are making. Release the mouse button
when you have selected the portion you want. The pointer position and the size of the
selected area ate displayed in the starus line (located at bottom of the Ricoh PhotaStudio
window) during the selecting operation.

If you decide you want to remove the existing selection, dick (but do not drag) anywhere in
the image.

You can also combine the existing mask with your new selection by holding down the Shift
key and dragging.

Tip: For more accurate selections, imagine that you are using the vectangle select toof to make a
rectangular selection that is just the right size to contain the oval area you want. Make sure the
mouse pointer is at one corner of that imaginary rectangular area before you start to click and
drag. Also, you may wans to my the Draw From Center option. (See “Options” below,)

When you double-click on the Ellipse Select Tool burton, a dialog bex will appear for more
aptions. Click QK to activare your setring,

Ellipse Select Option

Options in the Ellipse Select Tool dialog box:

Circle When this box is checked, the ool will always select perfectly
circular areas of your image. If you try to select an elliprical area,
the ool will limit the size of the selection to the largest possible
circle within that area.
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ﬂ Reference For Palettes And Tools

Draw From Center Allows you to draw elliptical selections out from the center of the
area you want to sclect, When this optien is on, simply dlick at
the center of the area you wanr to select and then drag the mouse
curwards.

Size Fixed When this option is turned on, the tcol will only select areas of
the fixed size you specify in the width and height fields. If you
turn the Cirele option on as well, Ricoh PhotoStudio will require

the width and height fields to be equal.

Freehand/Polygon Select Tool

To create irregulatly-shaped or polygonal selections, you should use this rool. You can also
make selections that are partly polygonal and partly irregular.

Irregular selections are made by pressing and dragging in the image window. Simply move
the mouse around the area you want to select. If you want a polygonal selection—like a srar
or an octagon—you only need to click the mouse on the points of the polygon, in a connect-
the-dots fashion. Ricoh PhotoStudic will connect the points where you click, (Note: The
Stamp Tool has a template feature that makes some pelygeonal selections easier.)

By using a combination of these two rechniques, you can create a selection that is partly
polygonal and partly trregular.,

You can also combine the existing mask with your new selection by holding down the Shift
key and dragging.

When you are ready to finish your selection, double-click on the point where you want to
end the sclection. Most people find it easiest to simply make the sclection and then double-
click on the place where they started, thus making a complete shape. If you do not double-
click where you started, Ricoh PhotoStudic will complete the selection: with straigh lines.

This tool has no options, so double-dicking on the tool button has ne effect.
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Magic Wand Tool

The Magic Wand Tool is very handy for situations wherc you want to select an area of your
image based on color similarity. (In grayscale and black-and-white images, it selects regions of
similar darkness.) For example, if your image is 2 landscape with a blue sky, you can use the
magic wand tool to sclect the sky without selecting the white clouds at the same time. Then
you can apply various effects to change the color of the sky.

To make this selection, you would just click on rhe sky with the magic wand tool. The tool
selects everything of that color or a similar color. The tool also has an option thart allows you
only to select a contiguous area of your image based on color similarity. In other words, it

will select all of the blue in the sky, but it won't select che blue ball that’s in the middle of the

meadow.

Of course, it’s not always that easy, since there are parts of the sky that are lighter than others,
and you may end up just selecting part of the sky. Also, ifyour image also includes a blue
lake that touches the sky, you may end up selecting the sky and the lake.

Howevet, you can change the tool’s sensitivicy by adjusting the options. Also, the tool can
add to the current selection when the Shift key is held down.

When you double-click on the Magic Wand Tool button, a dialog box will appear for more
oprions. Click OK to activate your setting,

Options in the Magic Wand Tool dialog box:

Contiguous Area Only If chis box is checked, the magic wand tool only selects the
contiguous area containing the pixel you click en. Otherwise, the
tool selects all pixels in the image that have the same or similar
<olor to the pixel where you clicked oxn.
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Reference For Palettes And Tools

Similarity This is the default serring for this tool. When this is the sctring,
the Magic Wand sclects the calor you click on and all colors that
are (1) touching the clicked-on color and (2) arc similar to the
clicked-on color. The similariry sensitiviry is specified by the
RGB stiding settings; the higher the numbers, the greater the
number of colors that will be selected.

Threshold When set to Threshold, the Magic Wand Tool categorizes all the
pixels in your image into two types: ones that have RGB values
that are all greater than the threshold settings, and others thar
have values equal to or below them. (A pixel with red and green
values greater than the respective threshold settings but a blue
value below the threshold blue value would fall into the “less
than” caregory.) Then when you click in your image, the tool
selects the color you click on and all colors that are (1) touching
the clicked-on color and (2) are in the same threshold category as
the first color.

RGB Sliders There are three sliders; one each for red, green, and blue. Each
one has a range of 0 to 255, which corresponds to the color
values given to each color in a Ricoh PhoroStudio image.

Mask Move Tool

The Mask Move Tool gives you the power to move the current mask ro a different part of
your image. When you click in the current selecrion and drag, the ol picks up the mask-—
without changing its shape, but leaving the currently-masked pixels behind—and relocates it
in your image window. In its new position, the mask acts just like any ordinary mask, and
any pixels within its borders will be affected by commands ot tools that you use.

This tool has no effect if you don’t have anything selected in your image window. It has no
opdons, so double-clicking on its tool button in the toolbox has no effect. Masks cannort be
moved berween images with this tool.
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Area Move Tool

Unlike the mask move tool, the area move tool moves both the mask and the pixels that lie
within its boundaries. To use it, click in the current mask and drag it to its new location.

The tool does not remove the original masked pixels; it only moves a copy of those pixels to
the new location. It’s like peeling off a copy of that part of your image and then placing the
copy clsewhere on the image. The copy is a floating selection, so you can move the copy as
many times as you like withour changing the image underneath it.

This tool does nothing if there is no current selection. It has no option dialog box. In
addition, you can also move the selected area withourt using Area Move Tool. Please see the
"Using the Keyboard" section in Chapter 2.

Zoom Tool

Clicking the left button in the acrive image window with this tool magnifies your view of the
image. This is likc using a magnifying glass to get a betrer look at your work; it does not

change the actual size of your image. (To change the image size, use the Resample command
in the Transform menu.}

You can see the current magnification ratio in the status bar at the bottom of the screen;
magnificacion of 1:1 is 100% (normal size), 2:1 is 200%, 3:1 is 300%, and so on.

To shrink the image, simply click with the right button in the active image window. 1:2 is
50%, 1:3 is 33%, 1:4 is 25%, and so on.

You can make your view as large as 16:1 or as small as 1:16.

Double-clicking on the zoom ool button sets the viewing ratio of the current image to 1:1.

Grabber Tool

To adjust the position of your image in the image window, click on your image with the
Grabber Tool and drag in the direction you want your image to move. For example, if your
image is very large and you can only sce half of it at a time, you can use this tool to move it
and look at the other half. It's more convenient than clicking on the image window scroll
bars because you can use it to move at any angle with one quick mouse movement.
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Reference For Palertes And Tools

If you have trouble gerting the hang of dragging your image in the right direction, try
thinking of your image as 2 large canvas hanging outside your little bathroom window. (The
canvas js your image, and the window is the image window.} Imagine that clicking on the
image is the act of grabbing the canvas. Then you drag the canvas in the direction yoeu want
it to move,

This does not affect your image in any way; it only adjusts your view of the image.

Double-dicking on the Grabber Teol butron has no effecr.

Text Tool

The Texr Tool allows you to add a line of text on the active image. To use i, click the tool on
the location where you want the rext to start. Since rext you create with this tool flows from
left to right, you should click at the top left corner of the area where you want the rext to

appear.

When you dick, the text dialog box appears for you to enter your text. Type the text you
want in the main dialog box area. Note that pressing return will have the same effect as

clicking on the OK button.

You can also click on the "Font” button to get the Select Font dialog box, which allows you
to change the font and add various styles and effects. Changes you make in the Select Font
dialog box will be applied to all of the text in the text dialog box.

i3
I Bookman O1d Style l
£

Braggadocio Bold ltalic
I Britannic Boid

AaBbYyZz
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Once you have created the text, it appears as a fleating selection thar can be repositioned
with the Arca Move Tool. The color of the text is the same as the active color. If you dick
again with the text tool, however, the floating selection will be released and Ricoh
PhotoStudio will prompt you with a new texr dialog box.

Options in the Text Tool dialog box:

Double-clicking on the Text Tool button shows up the Select Font dialog box, and allows
you to designate the default font settings for your text.

Stamp Tool

The Stamp Tool allows you to lay down a predefined shape on your image with every click
and drag of your mouse, If you do not set it to somerhing else, the Stamp Tool creates
rectangles and fills them with the active color ar 0% transparency (opaque). To usc it, click
and drag in your image to create the recrangle, just like you would do with the Recrangle
Select Tool if you were making a rectangular selection. If you don't like the result, use the
Trash Can Tool to discard the stamp.

You can define your own stamps, too. To do this, create a new 8-bit Grayscale image of the
same proportions that you want the stamp to have. Draw your stamp in white on a black
background. (If you want your stamp to have holes in it, draw them in black.) Then convert
the image to 1-bit Black-and-White format and save ir as a .BMP file in the "STAMPS" sub-
directory of the Ricoh PhotoStudio program directory. Quit Ricoh PhotoStudio and change
the files extension from .BMP 1o .STM (use the Rename command} so thar Ricch
PhotoSzudio will know it is a stamp file. When you run Ricch PhotoStudio again, the new
stamp name will appear in the list with the other predefined stamps in the Stamp Option
dialog box. (Refer to the Options discussed below.)

The Stamp Tool has many options you can access by double-clicking on the tool button.

i e M . il
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u Reference For Palettes And Tools

=] Stamp Option

rectangl.stm

Options in the Stamp Tool dialog box:

Source This list contains a library of predefined shapes like ellipse, line,
frame, arrow, and star. If you pick one of these shapes, the tocl
will create that shape until you change your selection again, or
until you quit Ricoh PhotoStudio.

Transparency Changes the transparency of the stamps made by the tool, from
0% (opaque) to 99% (so transparent you can barely tell thar you
made a stamp).

Draw From Center
Like the Recrangle Select Tool option, this option makes the
Stamp Tool create stamps from the center ourward. In other
words, when you dick and drag to create a stamp, the dick
defines che center of the stamp instead of the upper left cornet.

Default Size If this option is turned on, simply clicking with the Stamp Tool
will create a stamp of a predefined size. If the Draw From Ceater
option is on, the new stamp will be centered at the location
where you clicked; if not, it will be located below and to the
right of the place where you clicked. The defaulr size varies
depending on the current Souree selection.
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Gradient Fill Tool

This tool fills the current selection or the entire active image with a gradient from the
alternative to the active color. A gradient is a transition from one color to another, like the
rransitions you see between orange and blue near the horizon during a sunset.

To use it, click at the point where you want the gradient to begin and drag to designate the
length and direction of the transition. For example, if you want a gradual, sunset-like
gradient, set your alternative color to a sky blue and your active color to a deep orange. Then
click at the top of your image and drag straight down to the bortom. If you drag for a shorter
distance, the transition will occur more quickly. Also, you can have pare of the transition
occur outside of the current mask or image by dragging past the boundary of the mask or
image.

By default, gradients ate opaque (0% transparency), but you can change this by double-
clicking on the tool burton and changing the options.

Filt Gradient Qption

Options in the Gradient Fill Tool dialog box:

Color Model Ordinarily, gradienrs are made in the RGB scale. HSV makes the
gradient transition happen in the HSV color scale; the end result
is a rainbow-like transition berween the colors.

Transition Allows you to opt for a harsher transition.

Transparency Allows you to change the transparency of the gradicnt.
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Color Sweep

Bucket Fill Tool

Allows you to choose mu.ltiple gradients. If ¢his is set to 3, for
example, the transition you want will occur between the
alternative and active colors. However, right after changing to the
active color, it will transition right back to the alternative color,
and then back to the active coler once again, for a total of three
bands of changing colors.

The Bucker Fill Tool selects an arez based on color similarity and adds the active color 1o it.
It’s like the Magic Wand Tool (see Magic Wand Tool), except that after it makes the selection,
it fills the selected area with the active color. To use it, click on the area where you want to

add the active color.

Of course, you can change its characteristics by double-clicking on the tool button and

altering the options.

=] Bucket Fill Option

Options in the Bucket Fill Tool dialog box:

Transparency

Color Similariry

Changes the transparency of the active color that is added by the
roal.

Like the Magic Wand Tool, the Bucket Fill Tools similarity
option allows you to make the tool affect more or affect less of
the contiguous area where you have clicked. Setting this to a
higher number means that the tool will affect more of your
image. However, unlike the Magic Wand Tool’s similarity option,
you cannot separate the red, green, and blue spectrums. Your
similaricy setting is the same for all three.
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Airbrush Teol

This tool simulates the effect of an artist’s airbrush, slowly adding layers of the current active

| color on top of areas where you click and drag. For a stronger effect, drag back and forth over
the area several times. If the shape of the airbrush effect is not to your liking, change it using
the Show Brush Palette command from the View menu.

If you want the color to appear mote slowly or more transparently, you can change the rate of
application or transparency by double-clicking on the tool button and changing the options.

- REARAR e YT A B

Options in the Airbrush Tool dialeg box:

‘Transparency Changes the transparency of the color that is added by the
Airbrush (09 being opaque).

Rate of Flow Ordinarily, this is set to 100%. If you want to moderate the
speed at which the acrive color is added by the Airbrush, lower
this sctting.

pommAnAEPRARADOANRNNNAATN
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Paintbrush Tool

This teol applies a thick, opaque layer of the active color to the area where you click and
drag, (You can make the “paint” more transparent by changing the oprions.) Like a real
paintbrush, the color applied by the tool fades somewhat when you drag more quickiy.
Unlike a real paintbrush, the tool never runs dry; moving the mouse slowly will always create
the richest color allowed by the current settings.

Like the Airbrush Tool, the Paintbrush’s settings can be customized by changing the oprions
and/or altering the brush shape using the Show Brush Palette command from the View
menu.

‘When you double-click on the Paintbrush Tool button, a dialog box will appear for more
options. Click OK to activate your setting.

Pzintbrush Option

Options in the Paintbrush Tool dialog box:

Transparen Changes the transparency of the color thar is added by the
P y £ p cy ol
paintbrush (0% being opaque).

Rare of Flow Ordinarily, this is set to 100%. If you want to moderate the
speed at which the active coler is added by the paintbrush, lower
this serting.
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Smudge Tool

This roal simulates a finger smearing the “paint” in the image. It's a directional effect; if you
click in a red area and drag into a white area, you'll end up creating a small pink area in the
white section. Going in the opposire direcrion makes a pink area in the red section, Also, if
you drag faster, the effect is rougher and not as intense.

The shape of the brush is set using the Show Brush Palette command from the View menu.

Smudge Option

Options in the Smudge Tool dialog box;

Rare This changes the intensity of the smudge effect. A higher setring

creates a more intense CHCCE.

Pen Tool

This tool draws like a marker or felt-tip pen. In other words, when you click and drag in the
image, it draws an opaque line that’s the same color as the active color. (You can change the
transparency in the options.} If you drag more quickly, the line becomes less solid.

The shape of the brush 1s set using the Show Brush Palette command from the View menu.

Pen Option

Optioens in the Pen Tool dialog box:

Transparency Changes the transparency of the coler thar is added by the Pen
(0% being opaque).
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Brighten/Darken Tool

This tool brightens (or darkens, depending on current settings) the area in your image where
you click and drag the mouse. The shape of this tool can be changed using the Show Brush
Palette command from the View menu.

The tool cursor will change to reflect whether you are abour ro brighten or darken: when
brightening, the value of Brightness is larger than zero, the cursor is an arrow with a white
star; when datkening, the value of Brightness is negative, the cursor is an arrow with a black
star.

Options in the Brighten/Darken Tool dialog box: g

Brightness Changes the effect of this tool anywhere from 100% (completely
bright} to -100% (complerely dark).

i,
E
i

Smooth/Sharpen Tool

This brush-rype tool has an intetesting averaging or differentiaring effect in the area where
you click. It’s useful for smoothing rough edges and harsh wransitions, and for sharpening
areas that seem fuzzy. Drag to affect a larger arca. To ger the heaviest cffect, dlick (and drag, if
necessary) many times in same general area.

By default, the Smooth/Sharpen Tool is set to the smoothing function. (To change this
setting, double-click on the tool burron to bring up the options dialog.) Each time you
smooth an arez, Ricoh PhotoStudio averages the color of each affected pixel a litdde with the
colors of the pixels around it. This adds a general blur ot haze to the area and hides sharp
contrasts.

For example, if you have an image of small red polka-dots on a blue background, smoothing
it would make the edges of the dots blurry and purplish. A lot of smoothing would make the

Reference for Patettes and Tools 4-19




LRy

T

u Reference For Palettes And Tools

Whole area purpfe.

On the other hand, shatpening accentuates the contrast berween each affected pixel and its
neighbors, If it is the same color as the others but slightly darker, sharpening makes the pixel
darker and its neighbors lighter. Too much sharpening makes your image seem grainy.

The tool’s cursor will show you whether you are about to smooth or to sharpen. When you
are in smooth mode, the cursor is an arrow with an arc next to it; when in sharpen mode, the
arc becomes an angle.

The shape of the brush is set using the Show Brush Palerte command from the View menu.

To smooth or sharpen your entire image or selected area, use the filters from the Enhance

menu,

% SmaothiSharpen Option
¢ o

Options in the Smooth/Sharpen Tool dialog box
Tool Switches the tool berween Smooth and Sharpen mode.

Effect Changes the intensity of the smoothing ot sharpening.
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Clone Tool

This useful tool duplicates one part of your image in another part of the image. For example,
you can give a person a third eye in the middle of his forehead if you clone one of his existing

eyes,

Te do this, you'd click with right butron on the existing eye. This tells Ricoh PhotoStudio
where the soutce of the cloning will be; a plus sign (+} would appear at thar location for your
reference. Then you'd press and drag with the left burton in the middle of his forchead.

Of course, Ricoh PhotoStudio does not know exactly what you want to clone, so dragging
too wildly will deposit a nose on your victim’s left eye and an eyebrow in his hairline. Also,
each time you release the mouse button and press it down again, you tell Ricoh PhoroStudio
that you want to make ancther clonc in the current location, so uncontrolled dicking will
create 2 panorama of eyes.

One of the most powerful aspects of the Clone Tool is that you can clone between images.
Just set your source in one image, switch to the other, and clone. You can also activate the
Use Clipboard feature in the options dialog. This feature lets you use the image you have an
the Ricoh PhotoStudio clipboard as the source for your next cloning operation.

Like many other tools, the Clone tool’s area of effect is determined by the currenr setting in

the brush palerre.

When you double-click on the Clone Tool button, a dialog box will appear for more options.
Click OK to activate your setting,
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- 3 Options in the Clone Tool dialog box:

| Transparen
i parency
ik ’ Soft Edge

Use Clipboard

Changes the transparency of the cloned area(s} you are planning
to create. This is set to 0% by defaulr.

Makes the edge of the cloned area softer for a better visual match
with the existing image. This is turned on by default.

As mentioned in the main Clone Tool description, this feature
allows you to use the current clipboard image as the source for
the next cloning operation. If there is no image in the Ricoh
PhotoStudio clipboard, this option will be unavailable. The
location of the source point is hard to determine for clipboard
cloning, since you cannot see the plus sign on the clipboard, and
you cannot define a new source point by clicking the right
mouse button on the clipboard. The dipboard source point will
be located at the same coordinates as the last source point you
used (even if the last source point was not in the same image as
the clipboard image). If this is the first time you have used the
Clone Tool since you started Ricoh PhotoStudio, the clipboard
source peint will be located at the coordinates (0,0) — that is,
the very top lefr-hand corner.
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Revert Tool

This tool is like a medified eraser brush thar allows you to blend the changes you've made to
the currently masked 2rea together with the original stare of that area (the underlying image
area).

To use it, simply click and drag over the areas that you wanr to blend. By default, this tool
erases the floating selection affecred and restores the respective underlying (100%). You can
change this setting in the options dialog box.

Of course, you cannot make a change, make a few other alterations, mask the first change,
and then use this tool. It only affects changes that have been made while the current mask
has been active.

To undo all the changes you've made to the current selection, use the Trash Can Tool.

The shape of the brush is set using the Show Brush Palette command from the View menu.

When you double-click on the Revert Tool button, a dialog box will appear for more
options. Click OK to activate your setring. i

Options in the Revert Tool dialog box:

Underlying Changes the opacity of the pixels thar are being restored from the
underlying image area. By default, this is set to 100%.
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Transform Toof

This tool allows you te resize the current selection. When you choose this tool from the
toolbox, your selection instantly gains four small black squares at its four corners. (If your
selection is not rectangular, Ricoh PhotoStudio puts a temporary rectangular boundary
around it and the squares appear at the corners of this rectangle.) These are called “handles”
and they are not permancat; they disappear when the transformation is complere, Clicking
and dragging any one of them will allow you to resize the selection from tha side.

You can release the mouse butron and resize it again and again without the change taking
effect. To restore the otiginal selection size, double-click outside the selection boundaries. To
trigger the actual resizing operation, double-click within the selection. I you start the
operation and change your mind, you can cancel it by pressing the escape key (Esc).

The new resized selection appears as a floating selection; if you move it away with che Area
Move Tool, the underlying original image will appear untouched.

If you double-click on the tool button and change the options settings, you can use this tool
in three other ways:

Transform O

1) Rotate — rotates the selection around its center point. As you drag, the amount of
rotation (in degrees) appears in the status bar for your reference.

2) Skew — distorts the selection horizontally or vertically, depending on the initial direction
you drag the mouse. Visually, this effect makes your selection look like it is leaning to one
side (or up or down on one end}. Geometrically, this effect lets you give your selection the
shape of a parallelogram, and stretches or shrinks parts of the image to martch the new shape.
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3) Perspective — distorts the selection in such 2 way that it gives one end (left, right, top, or
botrom) the appearance of being cither in the distance or in the forcground. Geometrically,
this effect allows you to give your selection a trapezoidal shape, and stretches or shrinks parts
of the image to match the new shape.

Repeatedly transforming your selection until you get the result you want is not recorn-
mended, because each transformation operation reduces the sharpness of the selection.

Crop Tool

When you click on this tool’s button, it instantly copies the current selection from your
image and makes a new document out of it. The original document is left untouched. For
example, if you select the sun from your landscape image and then crop, a new, smaller
image window will appear, and it will only contain the sun. The rest of the landscape will be
left out of the new window.

This tool has no options dialog box.

|
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Eyedropper Tool

The Eyedropper Tool makes the active color the same as the color of the point you click on.
It also displays in the Status Line the color values of the pixels that you move the pointer
over. (As you can guess, this makes it much easier to create objects and shapes thar match
existing ones.}

Tip: The Eyedropper samples the point thats at the very tip of the eyedropper icon in the image
window. Its easy to accidentally sample the wrong color, especially since some areas that look solid
actually contain tiny spots of other colors. For example, an orange flower can contain tiny spots of
red and yellow. Make sure that the active color visually matches the color you want after you've
used this tool.

If you double-click on the toof buttan, a dialog box will appear for option’s setting.

= Color Option

Options in the Eyedropper Tool dialog box:

RGB and HSV Switches the color value display between RGB and HSV scales.

Trash Can Yool

Clicking on this tool's button instantly removes the current mask and all changes that have
been made in it. If you are about to try some experimentation on your image, it's often
handy to mask everything first so you can undo the changes made within the selection if
necessary.

Of course, you cannot make a change, make a few other alterations, mask the first change,
and then use this tool. It only affects changes that have been made while the current mask

has been acrive.

This tool has no options dialog box.
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Color Swatches

The color swarches ar the bottom of the toolbox are convenient indicators of your current
active and alternative color selections. The active color is the color that is applied to your
image by the varicus brush tools, and it is used by other functions and rools as well, It is also
the color that appears in the place of your selection after you perform a Cut command from
the Edit menu. The alternative color helps to determine the effect you get with the Gradient
Tool, and it is handy as an “on deck” color because you can make it into the active color
merely by clicking on its swarch.

- If you move the mouse pointcr over the color swatches, the status bar will show you what
they are and their respective color values.

To change the alternative color, dick on it to make it the active color, change the active color,
and then switch back to the original active color.

There are three ways to change the active color:

1} Use the Eyedropper Tool {Please refer to the Eyedropper Tool in Chapter 4). This is
the best methed for getting the active celor to match a color in your image. ‘

2) Use the Color Palette (Please see the Color Palette in Chapter 4). This is a quick way
to pick from the range of colors available in Ricoh PhotoStudio.

3} Double-click on the Active Color Swatch to bring up the Color Selection dialog box.
This is the best method when you want to use the HSV color system to choose a color,
or when you find the Color Palette’s selections to be too imprecise.

The Celor Selection Dialog Box:

This dialog box gives you many color selection options, including two different color
systems: RGB and HSV.

When the dialog box first appears, it is in RGB color mode with the red spectrum
selected. This is indicated by the button next to the R in the top right-hand corner. If
you know the RGB color values of the color you want to select, simply enter them into
the R, G, and B value boxes at the top right. Then cdlick the OK burton ro make that

your active color,

S,
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If you want to switch to the HSV color system, just click on the button next to the H,
S, or V ar the right. If you have specific HSV values, you can enter them in the value

boxes at this time.

The sliding scale at the top of the dialog box and the field below it provide a good ewo-
part system for in-depth color selection. The burtton that is clicked next to the R, G, B,
H. S, or V on the top right-hand side indicates the color characteristic you are currently
examining. The scale always shows the range of possible values for that characteristic.
For example, if the R burton is currently selected, the slider shows a range from black
(no red) to bright red. Clicking at different spots on the scale changes the amount of red

in the current color selection and in the field.

The field shows all the possible colors you could choose if you were to keep the current
red value and vary the other two values (green and blue). If the G button were currently
selected, the field would show varying levels of red and blue; if the H button were
selected, the field would show varying levels of saturation and brightness.

Using the sliding scale to isolate the most important color characteristic and the field to
pick from the resulting possibilities should make it easy for you to find the color you

want.

For your reference, the Old color patch shows the active color and the New color patch
shows the color selection you've made in this dialog box.
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Of course, if your monitor or video card cannot display 24-bit color, this dialog box cannot show the full range
of possible colots. Ricoh PhotoStudio will arrange the available colors in such a way thar you can get a good
general idea of how the colors would look if you had 24-bit color.

Tip: If you are simaply browsing for a color, it often heipful to click on the I buston to see the hues displayed like a
raimbow in the sliding scale. You can click on the hue you want and then pick out your color from the large field below
the scale.
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